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2. Introduction 
Welcome to the world of interactive volume visualization! In this manual we are going to 

introduce you to ImageVis3D, a lightweight, feature-rich volume rendering application 

which was specifically designed for rendering data which is significantly larger than the 

available memory of the machine. While ImageVis3D can take advantage of many recent 

advances in graphics hardware, advanced scheduling and caching algorithms ensure 

interactive performance even on older systems. We sincerely hope that ImageVis3D will 

improve the workflow in your environment and that you will have as much fun using it as 

we had developing it. If you have a question, bug-report, or feature request, feel free to 

contact us on the iv3d-users@sci.utah.edu mailing list, or use the built in “reporting” feature 

of ImageVis3D (see Section XVI on about details on this feature). 

I. Getting ImageVis3D 

If you already downloaded and installed the latest version of ImageVis3D on your system, 

feel free to skip this Section. 

a. Downloading 

ImageVis3D is a free open source program released under the MIT license, which means 

you can download, change, and do whatever you want with few restrictions (see Section 

XXIII). Practically, this means you can browse to http://www.ImageVis3D.com, click the 

download button and pick the latest binary that is suitable for your operating system (OS). 

If you do not know what your operating system is, and whether it is 32 or 64bit, ask you 

system administrator or consult your computer’s owner’s manual. If you feel more like 

playing around with the latest and greatest “in development” version of ImageVis3D you 

can also browse to http://software.sci.utah.edu/devbuilds/imagevis3d/ and download the 

latest build. These latest versions often offer new exciting features but are still under 

development and may not run as stable and reliable as the release versions that you can get 

from the “Download” site. 

b. Installation and Uninstallation 

As the installation of ImageVis3D differs between operating systems we will describe the 

process separately for the most common operating systems. 

Windows XP and above 

On Microsoft Windows you can either choose to run the installer directly by left-clicking the 

installer on the website (recommended) or right click the installer and choose to save it to 

your system. If you have downloaded the installer to your system instead of running it 

directly you should have either have an “ImageVis3D-1.0-64bit.exe” or “ImageVis3D-1.0-

32bit.exe” binary in your browser’s download folder (see Figure 1). 

mailto:iv3d-users@sci.utah.edu
http://www.imagevis3d.com/
http://software.sci.utah.edu/devbuilds/imagevis3d/
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Figure 1 64bit and 32bit Windows Installer Packages 

To start the installation process, double-click on the installer. On Windows Vista and 

Windows 7 you will be prompted by the “user account control” to allow the installer to run; 

just click “OK” to continue.  Next, you will see the familiar windows installer dialogs, as 

shown in Figure 2. We recommend that you leave all settings at their default values.  

 

 

Figure 2 The Install Wizard on Windows Systems 

After the wizard has finished the installation it will automatically start ImageVis3D or – if 

you have deselected the option to do so – you will have to start it manually by clicking on 

the new desktop item or by selecting ImageVis3D from Windows’ Start menu (bottom left 

on most systems). 

To uninstall ImageVis3D later all you have to do is to double-click ImageVis3D 1.0 from the 

software list (called Programs and Features on Vista and Windows 7) in the “Control Panel”. 
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OS X 

On a Macintosh computer running OS X, download the DMG disk image regardless of what 

Macintosh computer you have. This one image contains ImageVis3D versions for multiple 

configurations and automatically picks the right one. If you perform the download with the 

OS X default browser, Safari, the entire installation process will happen completely 

automatically. After the DMG has been downloaded, mounted, extracted, dismounted, and 

finally deleted, you should see the ImageVis3D program in your download folder. If you 

want to you can now move it into the application folder, so it is stored alongside with all 

your other OS X applications. 

If you ever want to uninstall ImageVis3D all you have to do is drag the ImageVis3D icon 

from the Download (or from the Application folder) into the Trash. 

Linux 

Linux binaries are distributed in two manners: from a Launchpad PPA (personal package 

archive), and as tarballs (with the extension tar.gz). 

The Launchpad PPA is only usable on apt-based Linux distributions, such as Debian and 

Ubuntu.  Information on configuring your distribution’s package update system to include 

ImageVis3D updates is available on Launchpad: 

 https://launchpad.net/~tfogal/+archive/ppa 

The second type of ImageVis3D Linux binary is a simple tarball containing the executable in 

a non-packaged form. This type of binary is distribution agnostic, and should therefore 

work on most Linux systems. To install this form of the binary, download the tarball and 

extract it using the tar(1) command. 

 tar zxvf ImageVis3D-1.3.tar.gz 

It is also possible to compile ImageVis3D directly from source; see Section XXIII for details. 

When using the tarball-based binary, you may need to install some dependency libraries to 

get ImageVis3D to run on your system.  If this is the case, the system will generate an error 

message detailing the list of missing libraries; in most cases, you will be able to simply load 

up your package manager and install the required libraries.  In some cases, you will need to 

compile ImageVis3D from source. 

When using the Launchpad PPA, all dependency requirements are handled automatically. 

II. Screenshots and Operating Systems 

As mentioned before, ImageVis3D runs on all major operation systems, such as Windows, 

OS X, and Linux. While the overall look and feel of the program remains the same, it will 

look slightly different on operating systems. For this manual we will mainly use screenshots 

https://launchpad.net/~tfogal/+archive/ppa
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from a Windows Vista system. As can be seen in Figure 3 this difference should not be a 

major problem, but if you still find it impossible to understand a certain part of this manual 

feel free to send an email to iv3d-users@sci.utah.edu and we will gladly help you with your 

problem and will also make the necessary changes to improve this manual for everyone 

else. 

        

Figure 3 ImageVis3D running on OS X and Windows Vista 

III. The First Start of ImageVis3D 

When you start ImageVis3D for the very first time the “Initial Setup Dialog” (see Figure 4) 

will open up and ask if you would like to change the default settings ImageVis3D has picked. 

For an inexperienced user it is best to just click, “No”, and accept the defaults. Later (in 

Section XV) we will describe how to change those settings if it becomes necessary. 

 

Figure 4 The Initial Settings Dialog 

If you accidently clicked “Yes” in the “Initial Setup Dialog” do not worry: just close the 

“ImageVis3D Settings Dialog” with either “OK” or “Cancel” and no harm is done.  

After you managed to pass the initial Setting/Setup phase ImageVis3D will start by 

presenting the “Welcome Screen” (see Figure 5).  

mailto:iv3d-users@sci.utah.edu
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Figure 5 The ImageVis3D Welcome Screen 

3. User Interface Basics 
In this Section we will introduce the basic concepts of ImageVis3D’s User Interface (UI). 

ImageVis3D was designed to be intuitive if you are already familiar with graphical user 

interfaces (GUIs) in general. Figure 6 shows an annotated screenshot of ImageVis3D’s user 

interface during a visualization session.  

 

 

Figure 6 ImageVis3D's UI elements 
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IV. The Welcome Screen 

If you start ImageVis3D the “Welcome Screen” (see Figure 5) opens up, unless disabled in 

ImageVis3D’s settings (see Section XV on how to re-enable it). In this window you can open 

data sets, see the video tutorials, open the local manual or the online help, or check whether 

you have the most recent version of ImageVis3D. To quickly try out ImageVis3D without 

having to use you own data you can also choose to download example data sets from our 

webpage. Particularly helpful in daily routine is that ImageVis3D keeps track of recently 

accessed data sets and lets you load these directly without having to find them on disk (see 

Figure 7).  

 

Figure 7 The Welcome Screen showing the most recently used items. 

 

V. The Main Menu 

Like most programs, ImageVis3D has a Main Menu from which the basic features are 

accessed (see Figure 8). For example, loading and saving from the “File”-menu or “Settings” 

from the “Edit”-menu. 

Loading and saving is down from the “File” menu; settings are accessed from the “Edit” 

menu (note that on OS X the Settings are located in the “ImageVis3D”-Menu on the top left 

as “Preferences”). Other menus are more specific to ImageVis3D’s task. The “View” menu 

will become important once we start working with multiple datasets at once (for details see 

Section XIII); the “Workspace” menu is used to load and save all of the “Tool” widgets (see 

Figure 6); finally, the “Help” menu gives access to the online help, automatic update, and 

bug reporting features of ImageVis3D. 
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Figure 8 ImageVis3D's Main Menu  
(The “Transfer ImageVis3D Mobile Device”-option is only visible when it is enabled in the Settings) 

VI. The Main Canvas 

c. Tool Widgets 

Key elements in ImageVis3D’s user interface are the “Tool Widgets”. These user interface 

elements contain most of the controls you need to operate ImageVis3D. To make 

ImageVis3D’s interface as flexible as possible, these widgets can be arranged freely by the 

user. It is also possible to completely hide such a widget if it is not needed, thus devoting 

more space to the Render Windows, and therefore the data under analysis. In Figure 6 a few 

of these Widgets are shown, with two of the widgets attached to the sides (left and right) 

and one widget floating freely. To attach a Widget to the sides, top, or bottom of the 

ImageVis3D window, drag it close to the border and release it. Please note that a Tool 

Widget can only be attached to a border of the main window if it fits, i.e. the main window is 

large enough accommodate the current Tool Widget at its minimum size. To detach a 

widget, click on its window icon (second icon from the right in the top bar of every widget). 

To re-attach that widget at the same location, double-click the top bar. To show a Tool 

widget select it in the workspace menu, to hide a widget either click on the cross icon 

(rightmost in the top bar) or deselect it in the workspace menu. You can also resize the Tool 

Widgets just like any other window in the user interface by dragging their borders. By 

default ImageVis3D remembers the layout of all of the Tool Widgets when it is closed and 

restores them when it is restarted. Sometimes, however, it is beneficial to have multiple 

predefined Tool Widget layouts at hand for different workflows. Thus it is also possible to 

save and load additional workspaces via the “Load Workspace” and “Save Workspace” 

options in the “Workspace” menu (see Figure 8). 

d. Render Windows 

The next important user interface element of ImageVis3D is the “Render Window”. It 

literally is the window to your data. In Figure 6 two such windows are shown (the hand 

data set and the stag beetle). Render windows are so similar to normal windows on your 

desktop, which can be maximized, minimized, or windowed, but Render windows are 

restricted to ImageVis3D’s main canvas. If you drag around your ImageVis3D main window, 
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the Render Windows will follow. Note that detached Tool Widgets are not restricted to the 

canvas and can be placed anywhere on your screen, even on another monitor if you have 

multiple monitors attached to your computer. To open a Render Window you need to Load 

a data set into ImageVis3D or clone an existing window. Also note that the arrangement 

options in the “View” menu (see Figure 8) apply to Render Windows. To interact with a data 

set left click and drag to rotate and right click and drag to move (see Section IX). 

4. Data Set Handling 
The primary focus of a scientific visualization tool is of course the data. In this Section you 

will learn how to convert data, load it into ImageVis3D, and also export it for other 

programs to use. 

VII. Loading Data 

In this first subsection we focus on opening data files from disk, whether they are in 

ImageVis3D’s native “UVF” format or foreign formats. 

e. Loading Native UVF Data 

ImageVis3D converts and stores all data sets in its own Universal Volume File (UVF) format. 

Once created these data sets are simple to load: select “Load Dataset From File” from the 

“File” menu and choose the UVF file in the file browser. (see Figure 9). 

      

Figure 9 Steps to load a UVF File 

After selecting the file from the file browser and clicking “Open” a new Render Window will 

be displayed within ImageVis3D showing the dataset. Note that you can also access the five 

most recently used datasets from the “Most Recently Used” entry in the “File”-menu (see 

Figure 9) or from the welcome screen (see Figure 7). 

Do note that ImageVis3D features a checksum feature to verify that the file being opened 

has not been corrupted. This verification process can take a considerable amount of time for 

large datasets, so users may consider disabling this feature in ImageVis3D’s “Settings” 

dialog. See Section XV for details. 
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f. Importing Data 

Often data is not stored in the UVF format already but in some other external format. In that 

case the data needs to be converted first. ImageVis3D distinguishes between two types of 

conversions, from a single file (or sometimes a two-file header/data pair) and from a stack 

of files. Prominent examples for single-file data are NRRD or RAW files, while stacked data 

most often comes from a DICOM stack or a set of slice images. 

Importing Data from a Single File (or a Header/Data Pair of Files) 

To import a dataset from a supported foreign file format, the same steps as for loading a 

UVF file are performed, as shown in Figure 9. ImageVis3D will automatically detect that the 

selected file is not a UVF dataset and will select the appropriate converter. ImageVis3D can 

import the following formats: 

 *.dat   QVis Data (including RGBA and float extensions) 

 *.nrrd & *.nhdr  Nearly raw raster data 

 *.stk   Metamorph STK Volumes 

 *.tiff & *.tif  TIFF Stack Volumes 

 *.vff   Visualization File Format 

 *.bov   VisIt Brick of Values 

 *.rek   Fraunhofer EZRT 

 *.*   Any raw data (text & binary encoding, zipped, bzipped) 

Next ImageVis3D asks for a target filename. As any foreign format is converted into UVF 

before visualization, a name for the newly created target UVF file has to be selected. 

 

Figure 10 RAW Data Loader Question Dialog 

If ImageVis3D cannot load the file with any of the known converters in the list above, it will 

ask whether the selected file is raw data and if the parameters can be supplied manually 

(see Figure 10). Next ImageVis3D presents the dialog shown in Figure 11, which asks for a 

manual specification of the dataset’s information. ImageVis3D will assist you in this by 

verifying the parameters given while they are entered. An information message above the 

“OK” and “Cancel” will tell you if the current parameters match the dataset (Figure 11). 



14 ImageVis3D Version 1.3 

 

14 

 

   

Figure 11 RAW Data Loader Dialog 

In both cases – when the file was detected as a known format or for the manual RAW loader 

– ImageVis3D will process the file, pre-computing derived quantities of the data (such as 

level of detail, histograms), write the converted data into the new UVF file, and finally load 

the UVF file. Note that the source dataset was only read by ImageVis3D during the 

conversion, so no changes were made to the input file, nor is the file required in the future 

(the generated UVF file can be loaded directly). Thus a conversion of a dataset only needs to 

be performed once. 

Importing Data from a Directory Containing DICOM Files or Slice Images 

While the previous section covered the loading of data in a single file (or pairs of files as in 

the case of QVis and some NRRD data), often the data are stored as a set of files. Data in the 

very popular DICOM format, for instance, are commonly stored as many separate files in a 

single directory. That same directory may even contain multiple distinct DICOM stacks. To 

load these DICOM or image stacks into ImageVis3D select “Load from Directory” instead of 

“Load From File” in the “File” menu. This will cause a directory selection dialog to open In 

that dialog select the directory that contains the data stack (see Figure 12).  
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Figure 12 The Open Directory Dialog (on Windows Vista) 

ImageVis3D will automatically scan the entire directory for DICOM and image stacks, order 

the stacks, and open a stack selection dialog as shown in Figure 13. 

 

Figure 13 Stack Selection Dialog 

In that dialog you can preview the volumes slice by slice by moving over a row in the table 

with the mouse, thus flipping through the data. You can also use the vertical slider on the 

right to adjust the brightness of the preview. If you found the right stack, select it by clicking 

on the respective row and select “OK”. The rest of the import process is similar to the single 

file process. First a filename for the new UVF file is requested, then the data are converted, 

and finally the data are loaded into ImageVis3D. Just as before, ImageVis3D does not modify 

the DICOM or image data nor does ImageVis3D require that stack in the future. 

Image Brightness Slider 

Move mouse here to preview data 
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VIII. Exporting Data 

ImageVis3D can also export UVF files into external formats for other tools to read the data. 

There are two kinds of data that ImageVis3D can export: the input data as a volume, and, 

given an iso-value, a triangle mesh that represents the iso-surface. 

g. Exporting Volumetric Data 

To export a dataset into an external volume format, it first needs to be loaded into 

ImageVis3D (see Section VII). Next select “Export Dataset” from the “File”-menu and select a 

target filename and file type (Figure 14, left and center). If your dataset is relatively small it 

will be exported instantly, for larger datasets another dialog will open (Figure 14, right) 

asking you which resolution you want to export. This allows you to export smaller versions 

of the data for use in software that does not support working with large datasets. 

 .  

Figure 14 Steps to Exporting a Volume 

h. Exporting Mesh Data from an Iso-Surface 

Instead of exporting the dataset as a volume, you may also want to export a triangular 

surface for a given iso-value (see Section m for details on iso-surface rendering). These data 

may then be processed using a mesh processing tool. To export data in this form, first load 

the dataset, then switch ImageVis3D into iso-surface rendering mode from the “Render 

Options”-tool widget (see Section v). Choose an appropriate iso-value from the “Isosurface 

Settings”-tool widget, and click on the “export as Mesh”-button (see Section z). Finally, you 

will be asked for a mesh filename and – just like for the volume export feature – will see a 

“LOD Level”-dialog for large datasets (see Figure 14, right). 

i. Transfer to an ImageVis3D mobile device 

To transfer data to an ImageVis3D Mobile (IV3Dm) enabled device at first IV3Dm features 

need to be enabled in the settings pane (see Section t). Once enabled a new menu entry 

“Transfer data to an ImageVis3D Mobile device” appears in the “File” menu (see Figure 8). 

Selecting this new option ImageVis3D opens up the data transfer dialog. If data is 

transferred for the first time the network port should be double-checked to make sure it is 

not blocked by a firewall or another application is using this port; if you have a firewall 

installed, note that ImageVis3D uses a single TCP port for the entire communication so only 

this port needs to be enabled in the firewall configuration, (22 by default). To prepare the 
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current dataset and its transfer function for the mobile device and initiate the transfer 

simply click start. On the mobile device enter the hostname or IP address of the computer 

running ImageVis3D and the port selected and start the transfer. 

 

 

 

Figure 15 ImageVis3D Mobile Transfer 

Windows Firewall 

On Windows you may see a message from the built-in firewall asking you to allow or deny 

ImageVis3D access to the network. You must allow ImageVis3D access for data transfer to 

work. After allowing ImageVis3D access, you must click on 'Start' again to actually start the 

network server (the previous ‘Start’ has been blocked by the windows firewall). 

j. Merging Datasets 

Besides loading, converting, and exporting datasets. ImagVis3D also allows the merging of 

multiple datasets into a single volume. This feature requires multiple input volumes of the 

same size. To start the merging process select “Merge Data sets” from the “File”-menu to 

open the merge dialog (see Figure 16, left and center). In this dialog click on the “Add Data 

Set” button to add as many datasets as you like, if Auto-Analyze is checked ImageVis3D will 

automatically check the added files for their size and values (as in Figure 16, right). Note 

that ImageVis3D does not need to open datasets for rendering just to merge them. The 

datasets also do not need to be in UVF format; ImageVis3D can merge data directly from all 

supported external formats as well. 

   

Figure 16 Merging multiple Datasets 
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Once all datasets that need to merged are added, the merge mode can be selected and every 

dataset can be scaled and biased. For every voxel of the merged dataset, m, one of the 

following merge equations is computed using the input datasets d1 to dn. 

a) 𝑚 = max  𝑑1 + 𝑏𝑖𝑎𝑠1 ⋅ 𝑠𝑐𝑎𝑙𝑒1,⋯ ,  𝑑𝑛 + 𝑏𝑖𝑎𝑠𝑛 ⋅ 𝑠𝑐𝑎𝑙𝑒𝑛  

b) 𝑚 =   𝑑𝑖 + 𝑏𝑖𝑎𝑠𝑖 ⋅ 𝑠𝑐𝑎𝑙𝑒𝑖
n
𝑖=0  

Equation a) is computed when “maximum” is selected, and Equation b) is computed when 

“add” is selected 

To start the merge process click “Save” and select a target filename. After merging, this file 

can then directly be loaded into ImageVis3D. Figure 17 shows an example of two datasets 

being merged into a single dataset. 

  

Figure 17 A Hydrogen Atom Dataset (left) merged (right) with a C60 Molecule (center) 

5. Interacting with the Data 
ImageVis3D’s focus is on the interactive exploration of large volume data, and thus naturally 

the interaction component is the most important part of ImageVis3D’s interface. There are 

two main ways of changing the appearance of a dataset. First, by changing the view 

parameters (e.g. rotating, translating, zooming) and second by changing the rendering 

parameters, such as the transfer function or iso-value. 

IX. Interaction inside the Render Window 

The primary means of interacting with render window is the mouse. Click and drag the left 

mouse button to rotate the dataset. Drag the right mouse button to move the dataset within 

the render window. Rotate the mouse wheel forward and backward to zoom closer or 

farther away from the dataset. 

ImageVis3D utilizes keys to control some aspects of the render window. While the render 

window has focus, 
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 Press the R key to reset the view 

 Press the C key to enable a small Coordinate cross, detailing the current dataset’s 

orientation. 

 Press the A key to toggle between Absolute and relative rotation 

 Press the Page-Up and Page-Down keys for fine scale zoom 

For a complete list of the keyboard controls, see Section XX 

X. Changing Render Modes 

ImageVis3D has three different 3D rendering modes: one dimensional and two dimensional 

transfer functions, and isosurface rendering. To change between them quickly, select the 

“Rendering Options” tool widget (see Section v) from the “Workspace” menu. The “Render  

Mode” can be selected by clicking the text of the desired mode with the left mouse button. 

Use the “…” button to quickly open the tool widget for changing properties specific to the 

associated render mode. 

Other global rendering settings are also configurable from the “Rendering Options” tool 

widget. The “Rescale” at the top can be used to scale the dataset in any dimension, to 

account for data formats which may not store enough information for ImageVis3D to 

discern this automatically (see Figure 18). Clicking “Save To File” on the top left will save 

the new scaling factor permanently to the UVF file. 

 

Figure 18. Using the ‘Rescale’ Feature To Correct the Aspect Ratio of a Dataset. 

ImageVis3D supports multiple execution models, mostly to provide a better user experience 

on older hardware. The default setting is “Continuous”, which causes the rendering to be 

updated instantly when any rendering parameter is changed (such as a transfer function or 

iso-value). The “On Release” setting waits until you release the mouse when interacting 

with the widget affecting the rendering parameter. Finally, the “Manual” execution mode 

waits for the user to click the “Apply” button before updating the render window with new 
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render settings. This setting is most useful on legacy hardware which cannot interactively 

re-render changes to the rendering parameters. 

Clip planes will be described in Section XI, so the last configurable options in the “Rendering 

Options” window are the “Render Settings.” “Global Bounding Box” will render a red box 

around the extents of the dataset; “Local Bounding Box” does the same for each individual 

“brick” of the dataset, which is mostly useful for developers. Finally, the “Sampling Rate” 

controls rendering quality: use lower settings for increased performance, and higher 

settings for generating publication-quality renderings. 

k. Working with a 1D Transfer Function 

One dimensional transfer functions are the typical manner for examining data in a volume 

rendering data. A transfer function is a mapping from the scalar values of the input dataset 

to color and opacity values. A volume renderer takes the transformed color and opacity 

values and blends them together. 

To edit a 1D transfer function in ImageVis3D, select the 1D Transfer Function editor from 

the “Rendering Options” tool widget (by left-clicking the “…” button to the right of the label), 

or the “1D Transfer Function Editor” from the “Workspace” menu. This will open the editor 

in a separate tool widget (see Section x).  

In the dominant portion of the widget is a function plot with a histogram of the data. Use the 

scrollbar on the rightmost side of the window to control the scale of histogram. The transfer 

function is (by default) the white line which forms a smooth-step function across the data. 

On the left are several checkboxes which allow one to control specific channels of the 

transfer function; popular groupings of the channels can be quickly selected via the radio 

buttons below, or the “User” setting can be used with the checkboxes to control the 

channels specifically. “Load” can be used to load an alternate transfer function; note that 

ImageVis3D will automatically load a transfer function based on the name of the dataset, 

using “1dt” as the file’s extension. “Save” can be used to record the current transfer function 

for later use, or to send to a colleague. Finally, the “Copy To 2D” button can be used to copy 

the current 1D transfer function into the active 2D transfer function. 

To change the transfer function, click and drag the left and right mouse buttons in the 

histogram on the right. Using the right mouse button allows general control over a 

smoothstep function from low to high, or high to low by holding the “shift” key. Moving the 

mouse up and down controls the inclination of the function’s slope, while moving right to 

left controls the location of the midpoint of the function. The left mouse button allows fine 

grained control of the transfer function. As mentioned earlier, only the channels which are 

enabled on the left will be modified by mouse interactions. Figure 19 shows two transfer 

functions and their effect on the same dataset. 
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Figure 19 Effect of 1D Transfer Function on a Dataset Rendering 

l. Working with a 2D Transfer Function 

Two dimensional transfer functions are an alternate method of describing a transfer 

function, and therefore of understanding scalar volume data. 

General 

To edit a 2D transfer function in ImageVis3D, select the 2D Transfer Function editor from 

the “Rendering Options” tool widget (by left-clicking the “…” button to the right of the label), 

or the “2D Transfer Function Editor” from the “Workspace” menu. This will open the editor 

in a separate tool widget (see Section y). 

In the dominant portion of the widget is a plot of the data on the X axis, and the gradient 

magnitude of the data on the Y axis. The opacity of a point is increased when many locations 

in the dataset share that same combination of values. As with the 1D transfer function 

editor, the scale can be controlled using the scrollbar on the right. Also in common with the 

1D transfer function editor are the “Load” and “Save” buttons located at the bottom left of 

the widget. As with 1D transfer functions, ImageVis3D will automatically load a transfer 

function with the same name of the dataset, but with the “uvf” extension replaced by a “2dt” 

extension. To zoom in or out of the 2D transfer function use the mouse wheel. Click the 

middle mouse button and drag the mouse to navigate in the zoomed transfer function (see 

Figure 20). 
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Figure 20 Zooming into a 2D Transfer Function 

2D transfer functions are described using a series of widgets which are layered on top of the 

plot to the right. By default, a large white square with a linear gradient is configured, 

normally causing a majority of the dataset to be visible. Figure 22 depicts the effect of the 

transfer function widgets on the rendering of the dataset. ImageVis3D offers two modes to 

interact place and modify the widgets. The "Basic Mode" that offers a simplified user 

interface while in "Expert Mode" the full potential of ImageVis3D's 2D transfer function 

modeling capabilities become accessible at the cost of a more complicated user interface. 

Basic Mode 

In basic mode only two different types of widgets can be placed within the domain, 

rectangles and triangles (technically the "triangles" are really trapezoids but we do call 

them triangles for historic reasons). In ImageVis3D arbitrarily many of these primitives can 

be added to the domain by pressing the "New .." buttons below the transfer function domain 

canvas (see Figure 21). To delete a widget, first select it by clicking inside it (a red border 

indices the selected widget) and press the "Delete ..." button below the domain canvas. To 

change the color and opacity of a widget make sure it is selected and press the "Choose 

Color" button and use the "Opacity" slider. 

 

Figure 21 The 2D Transferfunction Edit in Basic Mode 

To move any widget simply click and drag it. To resize a rectangle click and drag either the 

vertices or the edges, to change the center of a rectangle's gradient drag the green circle 
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within the rectangle. To reshape a triangle click on the top edge or its two vertices. To move 

the lower cutoff simply drag the lower edge of the triangle. 

At the very bottom of the basic "2D Transferfunction Editor" are the "Load" and "Save" 

buttons and the toggle button to switch to the "Expert Mode". As in "Expert Mode" more 

sophisticated polygon widgets and also more sophisticated gradients can be created, these 

polygons will show up as a third widget type. These "Other" widgets can be moved by 

clicking and dragging  within the widget and can be reshaped by dragging the edges and 

vertices. Note that ImageVis3D will continuously attempt to classify  these "Other" widgets, 

e.g. if a "triangle" is moved in expert mode the intersection point of the two side edges will 

most likely not be on the lower edge of the domain anymore, thus it becomes an "Other" 

widget. However, if it is moved to the correct height it re-attaches to the bottom of the 

domain and becomes a "triangle" again. 

Expert Mode 

To interact with a widget in expert mode, first select the corresponding widget from the 

“Polygons” list on the left. This will cause various components to be rendered on the 

highlighted widget: a red border, a series of yellow control points, and two green circles for 

gradient control. Left click and drag the mouse on any of the yellow control points to change 

the shape of the widget. Left click and drag on the green circles to control the falloff of the 

gradient. Right click to add a new control point to the widget (note that the name of the 

widget in the “Polygons” list will change accordingly when doing this). Conversely, right 

clicking directly on a control point will remove that control point from the widget. To resize 

the widget uniformly, hold the control key (command key on Mac), left click in the widget, 

and drag the mouse. To move the widget, hold the shift key, left click in the widget, and drag 

the mouse. Finally, to rotate the widget, hold shift and control (again, command on a Mac), 

left click in the widget, and drag the mouse up and down. 
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Figure 22 Effect of 2D Transfer Function Widget Positioning on a Dataset 

Creating a new widget is done with the buttons to the left of the plot, use one of the “Add” 

buttons. To delete a widget altogether, highlight it in the “Polygons” list and then click the 

“Delete” button. The “Up” and “Down” buttons control the ordering in the list, which also 

affects the compositing order and thus the renderings produced when two widgets overlap. 

Below the polygon list is a control to select whether the currently active widget should use a 

linear or radial gradient. When using a radial gradient, the left green circle of the widget no 

longer controls the falloff of the gradient, instead controlling the center of the circular 

gradient function. 

Near the bottom of the dialog is a control for the number of steps in the currently active 

widget’s transfer function. By default, there are three steps, at 0, 0.5, and 1. Steps can be 

added and removed using the “Add” and “Delete” buttons to the right, or modified by 

highlighting the step in the list and then using the color and opacity controls below. Click 

the “Choose Color” option to change the color of the currently highlighted step. Drag the 

“Opacity” slider to the left to make the function more transparent, or to the right to make 

the covered portion of the dataset opaque. Please note that light source colors specified in 

the lighting tool widget (see Section dd) change the global light source color while the 
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settings in the Isosurface widget change the material color of each layer. For best results it 

is recommended to leave either the light color or the surface color monochromatic. 

m. Working with IsoSurface Rendering 

ImageVis3D also supports an isosurface rendering mode, which renders a surface composed 

entirely of data points which share the same value. 

To edit the isovalue used for rendering, select the Isosurface Rendering editor from the 

“Rendering Options” tool widget (by left-clicking the “…” button to the right of the label), or 

the “Isosurface Settings” from the “Workspace” menu. This will open the editor in a separate 

tool widget (see Section z). The only relevant parameters are the color of the isosurface and 

the isovalue used to generate the surface. Drag the slider left and right to choose the 

isovalue. Click the “Choose Color” button to change the color of the isosurface. 

 

Figure 23. Multiple Isosurfaces and ClearView Rendering of the Same Two Isovalues 

n. Working with ClearView 

ClearView is a rendering mode which focuses on highlighting a region of interest without 

losing potentially important context in the data surrounding that region. It works by 

rendering two isosurfaces of the data, so-called “context” and “focus” isosurfaces. The focus 

isosurface is only displayed in a small region, controlled by the ClearView lens, whereas the 

context isosurface is displayed everywhere. Over the ClearView lens, the context 

isosurface’s prominent features are kept, but the isosurface is made mostly transparent to 

allow viewing of the focus isosurface. 

ClearView is controlled via the same tool widget as the isosurface rendering method. Select 

the “ClearView” checkbox in that window to enable the ClearView rendering mode. This will 

enable many of the UI elements which were previously grayed out below the normal 

isosurface settings. The context isosurface is controlled via the same slider which is used 

when rendering only a single isosurface. The slider labeled “Focus Isovalue” controls the 

isovalue used for the focus isosurface. Similar to the context isosurface, the focus 

isosurface’s color can be changed with the “Choose Focus Color” button. 

After enabling ClearView and selecting isovalues for both the focus and context isosurfaces, 

the ClearView lens can be moved over the dataset. To do so, move the mouse inside the 
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render window, and then begin holding “shift”. Now as the mouse moves, the ClearView lens 

will center itself on the mouse cursor. Note that it is not necessary to hold the left mouse 

button; simply moving the mouse is enough to change the location of the ClearView lens. 

Three new sliders are specific to the ClearView lens. The first, “Focus Size”, controls the 

radius of the lens. “Context Scale” controls how prominent features on the context 

isosurface will be when the ClearView lens is covering them. “Border” controls the width of 

the black line which details the edge of the ClearView lens. 

 

Figure 24.  Effect of the Focus Size ClearView Rendering Parameter 

XI. Clip Plane 

A clipping plane can be enabled via the “Rendering Options” tool widget. At the bottom of 

this widget is a group of three checkboxes which control how the clip plane affect rendering 

and interaction with the dataset. 

To enable the clip plane, check the “Enable” checkbox. By default, the “Show” and “Lock to 

Object” checkboxes will be checked. “Show” causes a visible widget to be drawn which 

highlights the plane being rendered.”Lock to Object” will cause the clip plane to be affected 

with view transformations which affect the dataset. 
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Figure 25 Example use of the clipping plane.  Half the data are clipped away so that the interior of the 
dataset is easily visible. 

The clipping plane uses the same mouse controls used in normal dataset interactions, 

except that the control key must be held down. Thus, to rotate the clipping plane, hold 

control, then left click and drag the mouse inside the render window. Similarly, hold control 

while right-clicking and drag the mouse to move the clip plane. 

XII. The Render Window Revisited 

Despite the name, “ImageVis3D”, the program is also capable of developing common 2D 

imagery, such as slice and MIP-based views. These rendering modes are configured via 

specific keyboard controls instead of the “Rendering Options” tool widget. 

o. Single Window vs. Two by Two View 

The default view is the 3D view, to properly display volumetric renderings. ImageVis3D also 

supports a 2x2 rendering mode, with the 3D view in the top left and the other three views 

comprised of axis-aligned slice planes. The slices planes are rendered by the current 1D or 

2D transfer function (note that the 1D transfer function is used when the isosurface render 

mode is enabled). To enable this mode, click in the render window you’d like to change to 

and hit ‘space’. In the 2x2 mode, the bottom left image shows slices along the Z axis; the 

bottom right shows slices along the X axis, and the top right shows slices along the Y axis.  
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Figure 26. Using Multiple Views.  3D rendering mode, Two-by-two Mode After Hitting ‘Space’, and Hitting 
‘Space’ Again to Highlight a Particular Slice View. 

To change which slice is displayed, hover the mouse pointer over the region which shows 

the axis you are interested in, and rotate the mouse wheel. The slices can be flipped along 

the X and Y axes by using the ‘X’ and ‘Y’ keys, respectively. To display the position of the 2D 

slice in 3D press the ‘P’ key (see Figure 27 center). To use the entire region for a particular 

slice view, hover the mouse pointer over that region and hit ‘space’. This can also be used to 

return to the normal 3D view, by hovering the mouse pointer over the top left image before 

hitting ‘space’. 

p. Maximum Intensity Projection (MIP) View 

ImageVis3D also supports a MIP rendering mode. A maximum intensity projection renders 

the maximum value along a series of slices. For example, in a CT scan of a head, a MIP is 

likely to pick up the skull as opposed to skin or brain tissue. 

 

Figure 27. Example of MIP Views; the Bottom Two Views use the MIP Rendering Mode also notice the 
plane position marker of the 2D slices in the 3D window in the top left in the 2 by 2 view. 

The MIP rendering mode can be enabled by hovering over a slice view and hitting the ‘m’ 

key. Note that the ‘X’ and ‘Y’ keys can still be used to flip the axes, as with the slice views. 

XIII. Working with multiple Windows 

ImageVis3D allows any number of render windows to be open at once. 
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q. Locking 

When multiple render windows are open in ImageVis3D, rendering parameters can be 

locked between them. This can be useful for analyzing the same dataset while changing only 

a single rendering parameter. For example, one could lock a view and change a transfer 

function, to observe the differences between transfer functions without worrying if the 

configured view settings are identical. To enable locking of multiple render windows, open 

the “Locking Options” from the “Workspaces” menu. 

As can be seen in Figure 45, the bottom of the widget contains a list of render windows, as 

described by the dataset which is loaded in them. Note that the currently active window is 

not shown, and thus the list of render windows will be empty if only a single render window 

is open. To lock settings, click the “View Transformation” or “Render Mode” options and 

then select the window which should be locked to the currently highlighted window in the 

list of render windows. Click a render window in the list a second time to deselect it, 

thereby unlocking it from the currently active render window. 

The “View Transformation” locking modality will lock view parameters between the two 

render windows. Thus every rotation, translation, or clip plane modification will propagate 

to locked windows. The “Render Mode” locking modality causes the three major rendering 

modes (1D transfer function, 2D transfer function, and isosurface rendering) to be locked 

between the render windows. 

XIV. Stereo Rendering 

ImageVis3D allows datasets to rendered in anaglyph red/blue stereo to enhance the illusion 

of depth perception. To enable stereo rendering in any render mode simply click on “Enable 

Stereo Rendering” in the “Stereo”-tool widget (see Section cc). You can use the “Eye 

distance” slider to increase or decrease the perceived depth and use the “Focal Length” 

slider to change the depth relative to the computer screen (i.e. if the image appears behind 

or in front of the screen). Figure 28 shows an example of such an anaglyph image. 
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Figure 28 An Anaglyph Stereo Image 

6. Capturing Images and Sequences 
Often it is helpful to send an image or movie of a specific view to a collaborator or integrate 

renderings into a publication. For this purpose ImageVis3D features a set of capturing 

options in the "Recorder" tool widget (see Figure 46 & Figure 29).  To better understand the 

capturing process we consider the ImageVis3D session as shown in Figure 29, which shows 

the cover image of this manual being generated. In that session a dataset has been loaded 

and the "Recorder"- tool widget has been opened.  
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Figure 29 Capturing in ImageVis3D 

 

In the text field of the "Recorder" tool widget the target filename for the captured image is 

shown. To change the filename, press the "..." button to the left of the text field and select a 

file. ImageVis3D automatically detects the file type by the file's extension (png in this 

example). If you press the "Single" - button a new file with the exact filename given in the 

text field is created overriding any existing file with that name. To capture multiple files 

with similar names press the "Sequence"-button instead. This will create files with a 

numbered added to sequentially order them, never overriding any data. The "Capture" - 

button on the bottom will automatically create a set of images while rotating the dataset 

around  the Y - axis. The number of images is specified in second dialog that opens once 

"Capture" is pressed (see Figure 30 left). Rotations can also be captured in MIP mode, which 

enables a few more options (see Figure 30 right). Note that when using the 3D view, images 

are automatically captured using the current view parameters, including stereo rendering. 

          

Figure 30 Full Rotation Capture Dialogs (3D view left, MIP view right) 

The result of a rotation capture is a set of images that can be easily used in many movie 

creating tools to create an animation of a spinning dataset. See Figure 31 for an example set 

of images created from the in Figure 29 by selecting to record 16 images. Note that those 
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images were captured with the "Preserve Transparency" switch turned off (seen in Figure 

29), thus showing the background as opaque. If the switch "Preserve Transparency" is 

turned on the transparency information is stored in the image if that image format supports 

transparency (e.g. PNG, TIFF). Capturing transparent images is useful if the image should 

later be combined with other images. Figure 32 shows the difference of a transparent and a 

non transparent image composited on top of a stripe pattern. 

 

Figure 31 A set of 16 images automatically created with the "Capture" feature 

 

 

Figure 32 A Transparent image (left) vs. Opaque Image (right) 



ImageVis3D Version 1.3 33 

 

33 

 

7. Working With Workspaces 
A very important part of ImageVis3D's User Interface is the concept of Workspaces. A 

Workspace is a particular layout of the Tool Widgets (see Section XIX for a list of all Tool 

Widgets). Unless changed in the settings ImageVis3D remembers the workspace once it is 

quit and restores it when it is restarted. Thus one a useful layout of the tool widgets is 

chosen ImageVis3D will always look the same. Sometimes, however, a single workspace 

only works for a specific task (e.g. specifying a 2D Transfer function) but may leave too little 

space for other tasks. Therefore, ImageVis3D allows the user to specify, save and load as 

many different workspaces as desired. Simply arrange the tool widgets in ImageVis3D as 

necessary for a certain task and then click "Save Workspace" in the "Workspace" menu or 

press Ctrl+Alt+S. To load a previously saved workspace from disk click "Load Workspace" in 

the "Workspace" menu or press Ctrl+Alt+L. To quickly toggle between most recently loaded 

workspaces you may also want to use the "Most recently used Workspaces" list in the 

"Workspace" menu or use the Ctrl+Alt+[number] shortcuts to quickly change workspaces. 

Hint: As the most recently loaded Workspace gets assigned to Ctrl+Alt+1 and the second 

most recent workspace is assigned to the shortcut Ctrl+Alt+2, pressing Ctrl+Alt+2 will 

toggle between the last two workspaces. 

8. Advanced Topics 

XV. Changing Parameters 

ImageVis3D has a number of settings to control performance and user interface behavior. 

When first run, ImageVis3D will ask if you would like to change these settings, but you can 

modify them at any time by selecting “Settings” from the “Edit” menu (on Mac: 

“Preferences” from the “ImageVis3D” menu). 

r. Memory 

ImageVis3D contains advanced memory management code to make sure it does not attempt 

to exceed the capabilities of your system. To effectively perform that task, it must know 

what those capabilities are. 
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Figure 33 ImageVis3D Settings Dialog "Memory" tab 

The GPU Memory slider tells ImageVis3D how much memory you have on your graphics 

card. Mac OS X users can obtain this information from the System Profiler. Linux users can 

normally glean the amount of video memory from /var/log/Xorg.0.log. The CPU Memory 

slider controls the amount of system RAM; ImageVis3D will assume it can access the 

amount of memory given here quickly. For this reason, especially if you're running many 

other applications, it can be a good idea to set the CPU Memory a bit lower than your 

system's actual available RAM. 

It is not so bad if you set these sliders a bit too low, but it can affect performance severely if 

you set them too high. Thus, if you are unsure, you should utilize conservative settings. It is 

essentially unheard of for any GPU to have less than64mb of memory these days; likewise, 

most systems purchased in the last 3 years have a gigabyte (1024 MB) of memory or more. 

s. Performance 

The Performance tab lets you customize the interactivity of ImageVis3D. The Open files 

without verification checkbox is off by default, and it is probably a good idea to leave it as 

such. ImageVis3D verifies that the data you load are not corrupt, so you can be sure you are 

viewing exactly what you saved last week (or your colleague was viewing before they sent it 

to you). However, this process can be slow, and so if you are opening the same file 

repeatedly it can be nice to disable the check. 
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Figure 34 ImageVis3D Settings dialog "Performance" tab 

The four sliders allow control of ImageVis3D's interactivity at the expense of raw 

performance. Minimal framer ate is a target frame rate that ImageVis3D will try to maintain 

at all times. Active Timeslice and Inactive Timeslice have the largest effect on interactivity; 

they control how often ImageVis3D will check to see if you are changing rendering 

parameters. Larger timeslices will lower total rendering time, but may cause ImageVis3D to 

feel as if it “lags” behind your input. 

ImageVis3D achieves interactivity using multiple levels of detail (LOD). A typical scenario 

for scientists using visualization software is to configure a particular viewpoint, transfer 

function, or combination of rendering parameters such that the feature of interest is visible 

or prominent. While interacting with the software, it can be a nuisance to do a complete 

render every time some small setting is changed, because a complete render can take quite 

some time, and many more changes will need to be made before settling on a 'final' 

rendering. LOD techniques allow us to do a quick 'preview' render in this scenario, so the 

user may get an idea of how the completed render will look without committing to the time 

required for a full render. 

To take advantage of this, ImageVis3D monitors how long it has been since the user 

changed a rendering parameter. If it has been 'long enough', then ImageVis3D will load and 

render the dataset at a higher resolution. The LOD Delay slider controls how long 

ImageVis3D will wait. 
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t. User Interface 

This tab contains settings for what ImageVis3D will remember across runs. 

 

Figure 35 ImageVis3D Settings dialog "User Interface" tab 

 Show version in title – Show the version number of ImageVis3D in the title bar of the 

main window. 

 Save Workspace on Exit – Saves the set of open windows, e.g. the transfer function 

editors, or rendering options windows. 

 Save Window on Exit – Which windows were open, plus rendering settings in those 

windows. 

 Lock Clones Windows – Whether or not a cloned window has its view parameters 

locked with the source window, by default. This setting can always be changed on a 

per-window basis via the “Locking Options” tool widget in the “Workspace” menu. 

 Absolute View Locks – Toggles between relative and absolute view locking. In both 

cases, rotation in one window will cause rotation in all windows which are locked to 

that window. With relative locking the view parameters allowed to differ, so you 

could (for example) view a volume from opposite angles. 

 Welcome screen at startup – Display the ImageVis3D welcome screen when 

ImageVis3D is launched, which provides quick access to recently used datasets and 

online help. 

 Invert MouseWheel – inverts the zoom function of the mouse wheel, it controls if 

scrolling up or scrolling down zooms in or out. 

 ImageVis3D Mobile features – enables server features for transfer to ImageVis3D 

mobile enabled devices. 
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 Automatic update check – Enable ImageVis3D’s automatic updating feature, which 

will inform you when a new version of ImageVis3D has been released. 

 Include Devbuilds – When checking for new versions (if Automatic update check is 

enabled), include a notification if a new “developer build” has been posted (note: 

developer builds may not be as stable and certainly aren’t as well-tested as a normal 

ImageVis3D release but may contain new features that are not included in the 

normal releases yet). 

u. Renderer 

The Renderer tab contains compatibility and quality settings. The Render Method selects the 

renderer type; in general, Slicing and 2D Slicing are compatible across more graphics cards, 

but Raycasting gives better quality. Blend Precision tells ImageVis3D how much detail to 

retain when rendering; 8 bit is supported across all graphics cards, but recent GPUs support 

16 bit or even 32 bit blending, which will generate higher quality images. 

 

Figure 36 ImageVis3D Settings dialog "Renderer" tab 

Compatibility options modify the manner in which ImageVis3D renders, in order to work 

around issues with graphics cards or bugs in GPU drivers. Use only power of 2 textures 

should be enabled on all but the most modern graphics cards; without it, ImageVis3D will 

perform poorly. Avoid Compositing is necessary to work around defects in some GPUs / GPU 

drivers. If an image seems to disappear into the background arbitrarily, or you notice 

polygons which seem to 'pop' and flicker as you rotate the volume, you will need this 

setting. Unfortunately this currently disables ImageVis3D's ClearView rendering mode. Use 

only 8Bit volume textures downscales even high resolution data down to 8 bits before 

sending it to the GPU. This is sometimes necessary to get very old video cards to run 

ImageVis3D, but can significantly degrade quality. Disable Border deals with a technical 
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rendering issue. Try checking the option and seeing the affect on performance for your 

system – leave it checked if the performance impact is negligible. Check the "Disable clip-

planes in raycaster" if you experience extremely slow performance in ray-casting mode 

(system appears to be frozen for minutes). 

The “Color” settings control how ImageVis3D uses color for the background and text 

annotations. The two buttons next to “Background” allow configuring a gradient 

background in render windows (see Figure 37). The “Select Color” button next to “Text” 

controls the color used for rendering of all text annotations in ImageVis3D; the adjacent 

slider controls the opacity. 

ImageVis3D can add a logo to each image it renders (see Figure 37), configured using the 

last section of the “Renderer” tab. Click the “Select File” button to open a dialog and browse 

to the desired image file. Click the “None” button to remove a previous choice and top 

rendering a logo. One of the four options on the right must be selected to detail where the 

logo should be rendered. 

 

Figure 37 Using logo and background gradients in a rendering. 

XVI. Reporting a Issue 

ImageVis3D has a built in dialog which can be used to report any undesirable behavior you 

may come across. This can be accessed via the “Help” menu or by pressing Ctrl+I. The 

ImageVis3D development team asks that you use this dialog whenever possible to report 

problems you encounter with ImageVis3D. Using this dialog automatically includes much of 

the most useful information for developers, and helps streamline your report for easy 

access and review. 
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Figure 38 ImageVis3D "Report an Issue" dialog 

XVII. The Debug Console 

ImageVis3D has a debug console to detail any problems it comes across while rendering, 

and include useful information on what it is doing ‘under the hood’. You can enable the 

debug window by selecting “Debug Window” from the “Help” menu or by pressing Ctrl+D. 

By default, the only information which is displayed will be errors, which means most 

systems would never see any output. However by enabling the “Warnings” and “Messages” 

checkboxes at the top of the window, detailed information about what ImageVis3D is doing 

will be displayed. 
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Figure 39 ImageVis3D's debug window with all debug channels enabled. 

For the most part, this information will not be useful to users, but developers can use it to 

help pinpoint an issue with ImageVis3D. The current debug log can be sent to the 

ImageVis3D developers by clicking the “Upload” button at the top right. Do note that the 

same information is also given when using the “Report an Issue” dialog, however. Finally, at 

the bottom of the window is a text input field to allow commands to be entered to 

ImageVis3D manually. 

XVIII. Running a Script 

ImageVis3D can run a script file which controls basics rendering parameters. This is useful 

for configuring ImageVis3D to immediately highlight a particular region of a dataset, or to 

generate images in batch, potentially from a series of datasets. 

ImageVis3D comes with a number of commands built-in, the most important of which being 

“open”, “resize”, “rotate[X|Y|Z]”, “capturesequence”, and “quit”. “open” opens a dataset and 

makes that the currently active render window. “resize” takes two parameters (e.g. “resize 

100 90”) and resizes the active window’s to match those arguments. The “rotate” 

commands (e.g. “rotateX 90”) take a single argument which gives the number of degrees to 

rotate around the given axis. Finally, “capturesequence” creates an image file of the given 

name, with an automatically increasing sequence number tacked on the end (see Section 

bb). 

A full list of commands can be found in the appendix, section XXI. 
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9. Appendix 

XIX. List of all Tool Widgets 

In this section we review the tool widgets available in ImageVis3D. 

v. The Rendering Options 

This widget controls the basic rendering parameters it is opened by pressing Ctrl+Alt+1. 

 

Figure 40 The "Rendering Options" Tool Widget 

w. The Progress Viewer 

The progress viewer details the current status of the rendering it is opened by pressing 

Ctrl+Alt+2. The top bar details the current level of detail (LOD) that ImageVis3D is 

rendering; the second bar shows the progress of that LOD as determined by the number of 

bricks already rendered for that level. It also contains the controls to limit the maximum 

and minimum quality levels. 

       

Figure 41 The "Progress Viewer" Tool Widget in activestate (left) and inactive state (right) 

x. The 1D Transferfunction Editor 

The 1D transfer function editor allows modification of the current 1D transfer function, it is 

opened by pressing Ctrl+Alt+3. 
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Figure 42 The "1D Transferfunction Editor" Tool Widget 

y. The 2D Transferfunction Editor 

The 2D transfer function editor allows modification of the current 2D transfer function it is 

opened by pressing Ctrl+Alt+4. 

 

Figure 43 The "2D Transferfunction Editor" Tool Widget (Basic Mode top / Expert Mode bottom) 

z. The Isosurface Settings 

The isosurface editor allows modification of the current isosurface and ClearView settings it 

is opened by pressing Ctrl+Alt+5. 
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Figure 44 The "Isosurface Settings" Tool Widget 

aa. The Locking Options 

The locking options widget controls which render windows are locked to the currently 

active render window, and in which modes those locks apply, it is opened by pressing 

Ctrl+Alt+6. “View Transformation” locks the view parameters, and “Render Mode” locks the 

usage of 1D, 2D, or isosurface renderers. Note that view locks take effect immediately, 

whereas render mode locks are only respected from the time of locking forward. 

 

Figure 45 The "Locking Options" Tool Widget 

bb. The Recorder Widget 

The recorder widget is used for saving images and series of images, it is opened by pressing 

Ctrl+Alt+7. Using the “Capture” button and corresponding UI, rotations about the Y axis can 

also be performed, outputting a series of images which can be assembled together into a 

movie using external tools. 

 

Figure 46 The "Recorder" Tool Widget 
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cc. The Stereo Widget 

The stereo widget enables and configures anaglyph rendering, which can enhance the 

illusion of depth which an image generates it is opened by pressing Ctrl+Alt+8. 

 

Figure 47 The "Stereo" Tool Widget 

dd. The Lighting Widget 

The lighting widget configures and previews the ambient, diffuse, and highlight colors and 

intensities of the light source. Please note that this widget changes the color of the light 

source. Thus, it is still possible in isosurface- and ClearView-mode to also change the object 

colors. 

 

Figure 48 The "Lighting" Tool Widget 

XX. List of Keyboard Shortcuts and Mouse Gestures  

ee. General 

 Ctrl+O - Load or Import a dataset from file 

 Ctrl+D - Import a dataset from a stack of files in a directory 

 Ctrl+ 1 - to Ctrl+ 5 - Load the most recently used datasets 

 Ctrl+M - Merge datasets 

 Ctrl+E - Export the current dataset 

 Ctrl+Q - Quit ImageVis3D 

 

 Ctrl+S - Open the settings dialog 

 

 Ctrl+Shift+C - Cascade the renderwindows 

 Ctrl+Shift+T - Tile the renderwindows 

 Ctrl+Shift+N - Bring next renderwindow to top 
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 Ctrl+Shift+P - Bring previous renderwindow to op 

 Ctrl+V Ctrl+1 - Activate single view for current window 

(or simply press space to toggle between 2x2 view and single view) 

 Ctrl+V Ctrl+2 - Activate 2x2 view for current window 

(or simply press space to toggle between 2x2 view and single view) 

 Ctrl+C - Clone the current renderwindow 

 Ctrl+Shift+L - Load ImageVis3D window geometry 

 Ctrl+Shift+D - Save the Default ImageVis3D window geometry 

 Ctrl+Shift+S - Save the ImageVis3D window geometry 

 

 Ctrl+Alt+L - Load a workspace from Disk 

 Ctrl+Shift+1 - to Ctrl+Shift+5 - Load the most recently used workspaces 

 Ctrl+Shift+S - Save the current workspace to disk 

 Ctrl+Shift+R - Reset the workspace to the default workspace 

 Ctrl+Alt+1 to Ctrl+Alt+8 opens/closes the tool widgets 

o Ctrl+Alt+1 - The Rendering Options 

o Ctrl+Alt+2 - Progress Viewer 

o Ctrl+Alt+3 - 1D Transferfunction Editor 

o Ctrl+Alt+4 - 2D Transferfunction Editor 

o Ctrl+Alt+5 - Isosurface Settings 

o Ctrl+Alt+6 - Locking Options 

o Ctrl+Alt+7 - Recorder Settings 

o Ctrl+Alt+8 - Stereo Options 

 

 Ctrl+A - Show the About Dialog 

 Ctrl+W - Open the Welcome Screen 

 Ctrl+M - Open this manual that came with your installation 

 Ctrl+H - Open the online help from the ImageVis3D webpage 

 Ctrl+T - Open the online Video tutorials 

 Ctrl+U - Check for updates of ImageVis3D 

 Ctrl+I - Report an issue to the ImageVis3D development team 

 Ctrl+D - Open the Debug and scripting Window 

ff. Render Window 

 r – Reset the render window parameters 

 c – Enable/disable the coordinate cross 

 space – switch between single and 2x2 view modes 

 x – swap slice view in the X dimension 

 y – swap slice view in the Y dimension 

 p - enable/disable the plane preview in the 3D window 
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 m – Enable/disable MIP rendering for slice views 

 a – toggles between absolute and relative rotation (i.e. if the rotation arc ball is 

moved together with the data set or stays in the center)  

 control (Windows / Linux), command (Mac) – hold to change clip plane orientation 

and position. 

 shift – hold to move the ClearView lens when ClearView is enabled (note: left 

clicking is not required!). 

 hold the left mouse button and drag the mouse to rotate the data set 

 hold the right mouse button and drag the mouse to move the data set 

 use the mouse wheel to zoom in or out 

 

gg. 1D transfer function editor: 

 hold the left mouse button and drag the mouse to draw the exact shape of a transfer 

function 

 hold the right mouse button and drag the mouse to insert a smooth-step function 

into the transfer function 

 shift – invert the direction of the smooth-step function (high to low instead of low to 

high) 

hh. 2D transfer function editor (Basic Mode): 

Rectangles 

 left click and drag an edge or vertex of a rectangle to resize it 

 left click and drag within a rectangle to move it 

 left click and drag the green circle within a rectangle to change the gradient center 

Triangles 

 left click and drag the two top vertices and the top edge of a "triangle" to reshape it 

 left click and drag the bottom edge to change the lower cutoff 

 left click and drag inside the triangle to change the position 

Other Polygons (created or modified in expert mode) 

 left click and drag an edge or vertex of a polygon to reshape it 

 left click and drag within a polygon to move it 

ii. 2D transfer function editor (Expert Mode): 

 shift – hold while dragging in the left mouse button to move the highlighted widget. 

 control (Windows / Linux), command (Mac) – hold while left clicking and dragging 

the left mouse button to resize the current widget 

 control + shift (Windows / Linux), command + shift (Mac) – hold while left clicking 

and dragging the mouse to rotate the currently active widget 
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 rotating the mouse wheel zooms in or out of the transfer function,  

 holding the middle mouse button while dragging the mouse pans the zoomed view 

XXI. List of Script Commands 

ImageVis3D supports many commands 

 "help" : show all commands 

 "execute" filename: run the script saved as 'filename' 

 "echo" on/off: turn feedback on successful command execution on or off 

 "time" : print out the current time 

 "date" : print out the current date 

 "write" test: print out 'text' 

 "seterrorlog" on/off: toggle recording of errors 

 "setwarninglog" on/off: toggle recording of warnings 

 "setemessagelog" on/off: toggle recording of messages 

 "printerrorlog" : print recorded errors 

 "printwarninglog" : print recorded warnings 

 "printmessagelog" : print recorded messages 

 "clearerrorlog" : clear recorded errors 

 "clearwarninglog" : clear recorded warnings 

 "clearmessagelog" : clear recorded messages 

 "fileoutput" filename: write debug output to 'filename' 

 "toggleoutput" on/off on/off on/off on/off: toggle messages, warning, errors, and other 

output 

 "clear" : clear this window 

 "versions" : print version information 

 "gpuinfo" : print basic information about the GPU, the driver and the rendering APIs 

 "gpuinfoext" : print extensive information about the GPU, the driver and the rendering 

APIs 

 "sysinfo" : print information about the system and the mem usage 

 "imageformats" : print a list of the supported image formats 

 "open" sourcefile [targetfile]: open the sourcefile and write it into targetfile if conversion is 

required 

 "open1d" sourcefile: open 1D transfer function sourcefile 

 "open2d" sourcefile: open 2D transfer function sourcefile 

 "setiso" isovalue: set an isovalue from 0 to 1 

 "setcviso" isovalue: set an isovalue from 0 to 1 

 "mode1d" : switch to 1D transfer function rendering 

 "mode2d" : switch to 2D transfer function rendering 

 "modeiso" : switch to isomode rendering 
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 "export" targetfile [LOD]: export the current dataset into 'targetfile' using LOD level 'LOD' 

default is 0 (max quality) the filetype is determined by the extension 

 "exportiso" targetfile [LOD]: export the current isosurface into 'targetfile' using LOD level 

'LOD' default is 0 (max quality) 

 "compare" file1 file2: compare file1 and file2 

 "close" : close the current datawindow 

 "resize" sizeX sizeY: resize the current data window 

 "rotateX" angle: rotate the data by "angle" degree around the x axis 

 "rotateY" angle: rotate the data by "angle" degree around the x axis 

 "rotateZ" angle: rotate the data by "angle" degree around the x axis 

 "translate" x y z: translate the data by [x,y,z] 

 "capturesingle" targetfile: capture a single image into targetfile 

 "capturesequence" targetfile: capture a single image into targetfile_counter 

 "stayopen" : do not close the application at the end of the script 

 "pack" source ... target: pack the files source0 to sourceN into a single file target 

 "upload" source [target]: upload the file 'source' to the debug server with the name 'target' 

(by default a unique filename is generated automatically) 

 "delete" file: delete the file 'file' 

 "quit" : quit ImageVis3D 

XXII. Command Line Parameters 

ImageVis3D can be started with a few different command line options which can change the 

runtime behavior. 

 -log filename – Create logging output in filename. The special filename “-“ can be 

used to indicate the standard output stream. 

 -loglevel level – The level of debug output put in the file given by –log 

 -script scriptfile – Load a script and execute the commands on startup. 

XXIII. Compiling ImageVis3D 

ImageVis3D requires the Qt library to compile. In the ImageVis3D subversion repository we 

supply some scripts in the Scripts directory which can compile Qt from source automatically 

on each of the major platforms. If you are on windows, make sure to set the QTDIR32, 

QTDIR64, or both (depending on which configurations you want to build for) environment 

variables to the root location of the Qt installation. 

Once you have a working Qt installation, grab the sources from the ImageVis3D subversion 

repository, using the svn URI: 

 https://gforge.sci.utah.edu/svn/imagevis3d/ 

https://gforge.sci.utah.edu/svn/imagevis3d/
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On Windows systems, open up the ImageVis3D.sln file in Visual Studio 2008 or newer, and 

compile as is normal for this platform. On Linux, Mac, and other similar systems, open up a 

terminal, change directory to the newly checked out subversion repository, and run: 

 sh Scripts/unix-dev-cfg.sh 

 make –j2 

This will compile ImageVis3D. The output binaries are stored in the Build directory; on 

Linux, there is a plain ImageVis3D binary. On Macintosh systems, a ImageVis3D.app bundle 

will be created in the Build directory. 

XXIV. The MIT License 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software 

and associated documentation files (the "Software"), to deal in the Software without 

restriction, including without limitation the rights to use, copy, modify, merge, publish, 

distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom 

the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or 

substantial portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 

THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 

OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 

ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 

OTHER DEALINGS IN THE SOFTWARE. 

XXV. List of Images 

Figure 1 64bit and 32bit Windows Installer Packages ............................................................................. 6 

Figure 2 The Install Wizard on Windows Systems ..................................................................................... 6 

Figure 3 ImageVis3D running on OS X and Windows Vista .................................................................... 8 

Figure 4 The Initial Settings Dialog ................................................................................................................... 8 

Figure 5 The ImageVis3D Welcome Screen ................................................................................................... 9 

Figure 6 ImageVis3D's UI elements .................................................................................................................. 9 

Figure 7 The Welcome Screen showing the most recently used items. .......................................... 10 

Figure 8 ImageVis3D's Main Menu ................................................................................................................. 11 

Figure 9 Steps to load a UVF File ..................................................................................................................... 12 

Figure 10 RAW Data Loader Question Dialog ............................................................................................ 13 

Figure 11 RAW Data Loader Dialog ............................................................................................................... 14 

Figure 12 The Open Directory Dialog (on Windows Vista) .................................................................. 15 



50 ImageVis3D Version 1.3 

 

50 

 

Figure 13 Stack Selection Dialog ..................................................................................................................... 15 

Figure 14 Steps to Exporting a Volume ........................................................................................................ 16 

Figure 15 Merging multiple Datasets ............................................................................................................ 17 

Figure 16 A Hydrogen Atom Dataset (left) merged (right) with a C60 Molecule (center) ..... 18 

Figure 17. Using the ‘Rescale’ Feature To Correct the Aspect Ratio of a Dataset. ...................... 19 

Figure 18 Effect of 1D Transfer Function on a Dataset Rendering ................................................... 21 

Figure 19 Zooming into a 2D Transfer Function ...................................................................................... 22 

Figure 20 Effect of 2D Transfer Function Widget Positioning on a Dataset Rendering ........... 24 

Figure 21. Multiple Isosurfaces and ClearView Rendering of the Same Two Isovalues ........... 25 

Figure 22.  Effect of the Focus Size ClearView Rendering Parameter .............................................. 26 

Figure 23 Example use of the clipping plane.  Half the data are clipped away so that the 

interior of the dataset is easily visible. ......................................................................................................... 27 

Figure 24. Using Multiple Views.  3D rendering mode, Two-by-two Mode After Hitting 

‘Space’, and Hitting ‘Space’ Again to Highlight a Particular Slice View. ........................................... 28 

Figure 25. Example of MIP Views; the Bottom Two Views use the MIP Rendering Mode also 

notice the plane position marker of the 2D slices in the 3D window in the top left in the 2 by 

2 view. ........................................................................................................................................................................ 28 

Figure 26 An Anaglyph Stereo Image ............................................................................................................ 30 

Figure 27 Capturing in ImageVis3D ............................................................................................................... 31 

Figure 28 Full Rotation Capture Dialogs  (3D view left, MIP view right) ....................................... 31 

Figure 29 A set of 16 images automatically created with the "Capture" feature ........................ 32 

Figure 30 A Transparent image (left) vs. Opaque Image (right)........................................................ 32 

Figure 31 ImageVis3D Settings Dialog "Memory" tab ............................................................................ 34 

Figure 32 ImageVis3D Settings dialog "Performance" tab ................................................................... 35 

Figure 33 ImageVis3D Settings dialog "User Interface" tab ................................................................ 36 

Figure 34 ImageVis3D Settings dialog "Renderer" tab .......................................................................... 37 

Figure 35 Using logo and background gradients in a rendering. ....................................................... 38 

Figure 36 ImageVis3D "Report an Issue" dialog ....................................................................................... 39 

Figure 37 ImageVis3D's debug window with all debug channels enabled. ................................... 40 

Figure 38 The "Rendering Options" Tool Widget ..................................................................................... 41 

Figure 39 The "Progress Viewer" Tool Widget in activestate (left) and inactive state (right)

 ....................................................................................................................................................................................... 41 

Figure 40 The "1D Transferfunction Editor" Tool Widget ................................................................... 42 

Figure 41 The "2D Transferfunction Editor" Tool Widget ................................................................... 42 

Figure 42 The "Isosurface Settings" Tool Widget .................................................................................... 43 

Figure 43 The "Locking Options" Tool Widget .......................................................................................... 43 

Figure 44 The "Recorder" Tool Widget ........................................................................................................ 43 

Figure 45 The "Stereo" Tool Widget .............................................................................................................. 44 

 


	Introduction
	Getting ImageVis3D
	Downloading
	Installation and Uninstallation
	Windows XP and above
	OS X
	Linux


	Screenshots and Operating Systems
	The First Start of ImageVis3D

	User Interface Basics
	The Welcome Screen
	The Main Menu
	The Main Canvas
	Tool Widgets
	Render Windows


	Data Set Handling
	Loading Data
	Loading Native UVF Data
	Importing Data
	Importing Data from a Single File (or a Header/Data Pair of Files)
	Importing Data from a Directory Containing DICOM Files or Slice Images


	Exporting Data
	Exporting Volumetric Data
	Exporting Mesh Data from an Iso-Surface
	Transfer to an ImageVis3D mobile device
	Windows Firewall

	Merging Datasets


	Interacting with the Data
	Interaction inside the Render Window
	Changing Render Modes
	Working with a 1D Transfer Function
	Working with a 2D Transfer Function
	General
	Basic Mode
	Expert Mode

	Working with IsoSurface Rendering
	Working with ClearView

	Clip Plane
	The Render Window Revisited
	Single Window vs. Two by Two View
	Maximum Intensity Projection (MIP) View

	Working with multiple Windows
	Locking

	Stereo Rendering

	Capturing Images and Sequences
	Working With Workspaces
	Advanced Topics
	Changing Parameters
	Memory
	Performance
	User Interface
	Renderer

	Reporting a Issue
	The Debug Console
	Running a Script

	Appendix
	List of all Tool Widgets
	The Rendering Options
	The Progress Viewer
	The 1D Transferfunction Editor
	The 2D Transferfunction Editor
	The Isosurface Settings
	The Locking Options
	The Recorder Widget
	The Stereo Widget
	The Lighting Widget

	List of Keyboard Shortcuts and Mouse Gestures
	General
	Render Window
	1D transfer function editor:
	2D transfer function editor (Basic Mode):
	Rectangles
	Triangles
	Other Polygons (created or modified in expert mode)

	2D transfer function editor (Expert Mode):

	List of Script Commands
	Command Line Parameters
	Compiling ImageVis3D
	The MIT License
	List of Images


